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Warranty and liability

Warranty and liability

Note

Security
informa-
tion

The Application Examples are not binding and do not claim to be complete
regarding the circuits shown, equipping and any eventuality. The Application
Examples do not represent customer-specific solutions. They are only intended
to provide support for typical applications. You are responsible for ensuring that
the described products are used correctly. These Application Examples do not
relieve you of the responsibility to use safe practices in application, installation,
operation and maintenance. When using these Application Examples, you
recognize that we cannot be made liable for any damage/claims beyond the
liability clause described. We reserve the right to make changes to these
Application Examples at any time without prior notice.

If there are any deviations between the recommendations provided in these
Application Examples and other Siemens publications — e.g. Catalogs - the
contents of the other documents have priority.

We do not accept any liability for the information contained in this document.

Any claims against us — based on whatever legal reason — resulting from the use of
the examples, information, programs, engineering and performance data etc.,
described in this Application Example shall be excluded. Such an exclusion shall
not apply in the case of mandatory liability, e.g. under the German Product Liability
Act (“Produkthaftungsgesetz”), in case of intent, gross negligence, or injury of life,
body or health, guarantee for the quality of a product, fraudulent concealment of a
deficiency or breach of a condition which goes to the root of the contract
(“wesentliche Vertragspflichten”). The damages for a breach of a substantial
contractual obligation are, however, limited to the foreseeable damage, typical for
the type of contract, except in the event of intent or gross negligence or injury to
life, body or health. The above provisions do not imply a change of the burden of
proof to your detriment.

Any form of duplication or distribution of these Application Examples or excerpts
hereof is prohibited without the expressed consent of the Siemens AG.

Siemens provides products and solutions with industrial security functions that
support the secure operation of plants, systems, machines and networks.

In order to protect plants, systems, machines and networks against cyber
threats, it is necessary to implement — and continuously maintain — a holistic,
state-of-the-art industrial security concept. Siemens’ products and solutions only
form one element of such a concept.

Customer is responsible to prevent unauthorized access to its plants, systems,
machines and networks. Systems, machines and components should only be
connected to the enterprise network or the internet if and to the extent necessary
and with appropriate security measures (e.g. use of firewalls and network
segmentation) in place.

Additionally, Siemens’ guidance on appropriate security measures should be
taken into account. For more information about industrial security, please visit
http://www.siemens.com/industrialsecurity.

Siemens’ products and solutions undergo continuous development to make them
more secure. Siemens strongly recommends to apply product updates as soon
as available and to always use the latest product versions. Use of product
versions that are no longer supported, and failure to apply latest updates may
increase customer’s exposure to cyber threats.

To stay informed about product updates, subscribe to the Siemens Industrial
Security RSS Feed under http://www.siemens.com/industrialsecurity.
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1 Task

1 Task

1.1 Overview

Introduction

In some processes, there is a requirement for data to be archived in rapid cycles.
The cycle time of conventional archiving with WinCC Tag Logging is at least
500ms.

To archive data faster than 500ms, one must find another solution.

To achieve faster archiving of process data, it is also important to have a low load
on the system bus.

Overview of the automation task
The following figure provides an overview of the automation task.

Figure 1-1
AS WinCC
measured Tag Logging
values
update rate i update rate i
)< 500ms )2 500ms
1.2 Requirements

In order to further improve the existing process data archiving, the following
requirements must be met.

e [Faster archiving rates than 500ms
e The load on the system bus must be kept as low as possible
e The solution should apply for the SIMATIC PCS 7

Fast archiving of process
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2 Solution

2
2.1

Solution

Overview

The S7-400 / WinAC RTX system function block AR_SEND / SFB 37 is the ideal
choice for applications requiring faster process data archiving.

This block is responsible for the communication between the automation system
(AS) and the operator station (OS) and sends the data to WinCC where it is then
added to the archive "TagLogging Fast".

Based on this block, we provide two function blocks

(ARSCAN_E and AR_MAN_E), which allow you to achieve a higher data
throughput when archiving measured values, compared to requesting the data on
the initiative of the OS.

To keep the load on the system bus as low as possible, the process data is stored
in the AS and sent in bundles to the OS.

The function blocks ARSCAN_E and AR_MAN_E have been developed based on
the system function block AR_SEND / SFB 37 to save measured values as
efficiently as possible and to transmit it in bundles to the OS.

e The block ARSCAN _E is used for capturing and saving one single process
value of the data type REAL or DWORD.
An ARSCAN _E block is used for each process value.
There are two ways of capturing the process data.

- Cyclical acquisition of process data is used to archive process values in an
equidistant manner (at fixed intervals of time).

- Event-driven acquisition of process data is used if a process value is to be
archived as soon as its value changes. The use of this variant is limited to
process values of data type REAL.

e The block AR_MAN_E includes FIFO memory for process data and manages
the sending of bundled data to WinCC by means of the system function block
AR_SEND.

Several ARSCAN_E blocks can be connected to a single AR_MAN _E block
(one ARSCAN_E per process value) and write to the FIFO memory.

The following figure shows a schematic representation of the two blocks used for
the fast archiving of process data.

Fast archiving of process
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2 Solution

Figure 2-1
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Typical areas of application

e Fast archiving of process data with the data types DWORD and REAL
(<500ms)

e Intermediate storage of process data in AS

e Flexible archiving time for process values (when they change, equidistant,
manual)

Advantages
e Easy interconnection of process tags in the CFC editor
e Simple parameter assignment of the system function block AR_SEND
e Providing the necessary header information for the AR_SEND block
e Precise time stamp on process data from the AS
e Variable trigger options for sending the data to WinCC
e Automatic frame repetition in case of error

Required knowledge

It is required to have basic knowledge of automation systems and SIMATIC PCS 7.
This application example was created with SIMATIC PCS 7 V8.1
(SCL V5.3 SP6 Upd3).

Fast archiving of process
Entry ID: 23780904, V2.2, 08/2016 6
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2 Solution

2.2 Hardware and software components

221 Scope

Valid for SIMATIC PCS 7 V8.2

Note The use of this solution is also possible in STEP 7 and WinCC, but it is not
explicitly described in this example.

The only prerequisite is the configuration and runtime environment with the
appropriate licenses and an automation system that supports the system
function block AR_SEND / SFB 37.

222 Components used

The Application Example has been created with the following components:

Hardware components

Table 2-1
Component Qty. Order number Note
Rack 1 6ES7400-1JA11-0AA0 or equivalent
PS 407 10A power 1 6ES7407-0KA02-0AA0 or equivalent
supply
SIMATIC S7-410-5H 1 6ES7410-5HX08-0ABO or equivalent
Controller S7-400/ S7-400 H
WiInAC RTX
Software components
Table 2-2
Component Qty. Order number Note
SIMATIC PCS 7 1 6ES7651-5AA28-0YAD ES Singlestation V8.2
V8.2
S7-PLCSIM 1 6ES7841-0CC05-0YA5 If the AS of the example
project is to be simulated
with S7-PLCSIM

Example files and projects

The following list contains all the files and projects used in this example.

Table 2-3

Component

Note

23780904_FastArch_mp_V82.zip

This file complies with the PCS 7 example project and
can be retrieved directly via the SIMATIC Manager.

23780904_Code.zip

e AR _MAN E
e ARSCAN E

The file contains the SCL sources of the blocks:

Fast archiving of process
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3 Basics

3 Basics

3.1 Operating principle of the Application Example

Two ARSCAN_E blocks detect a test signal.
The first block saves the process value in an event-driven manner, and the second

block in a cyclic manner.

The block AR_MAN_E allocates FIFO memory for the process data and by means
of AR_SEND, it sends the data in blocks to WinCC, where it is then added to the
archive "Tag Logging Fast".

The following figure shows a schematic illustration of the functioning of the
Application Example.

Figure 3-1

WinCC Tag Logging ﬁ
test signal /

T
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event-
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fast
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CAUTION  Since the block ARSCAN_E is connected to the block AR_MAN_E and it
accesses its information, the block ARSCAN_E should be called up in the
run sequence following the block AR_MAN_E (to ensure the timeliness of
this information).

However, with this constellation, the current process data in the block
AR_MAN_E won't be processed before the next cycle.

Fast archiving of process
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3 Basics

3.2

Overview

Functionality of the block AR_SEND

You can find detailed information about the AR_SEND block in the WinCC Online
Help at

"WinCC Information System > Communication > SIMATIC S7 Protocol Suite >
Special functions > Data exchange with the S7 function block AR_SEND".

Archive data transmission using AR_SEND

The AR_SEND block can supply various versions of archive tags with data.
e One archive tag (AR_ID sufficient)
e Multiple archive tags (AR_ID and AR_ID subnumber)

AR_ID and AR_ID subnumber establish the assignment between the data in the
AS and the archive tags.

Each AR_ID can have theoretically up to 4095 AR_ID subnumbers. However

in practice, the number of archive tags per AR_SEND instance is limited by the
maximum length of the data area to be transmitted.

The AR_SEND block also offers a variety of formats to transfer process data in
the WinCC Tag Logging, e.g. more process values with the same time stamp or
process values with time difference to the last value.

AR_SEND Performance

It is to be noted that there is a resource restriction when using the S7 functions
AR_SEND and BSEND/BRCYV for communication with S7-400.

That is, the maximum amount of data that can be transmitted simultaneously from
AS to WinCC with the functions AR_SEND and/or BSEND/BRCYV is limited to max.
16 kByte.

CAUTION

The data amount limit in the WinCC communication channel must be
always observed. Please also note that in case of redundant systems,
the maximum amount of data is halved.

For detailed information about the resource limit, please read the
paragraph "Number of process values" in the WinCC Online Help under
"WinCC Information System > Communication > SIMATIC S7 Protocol Suite
> Special functions > Data exchange with the S7 function block AR_SEND>
Structure and parameters of a data block".

Fast archiving of process
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Limitation of AR_SEND instances

The maximum number of AR_SEND instances that can be connected
simultaneously to each CPU is limited and depends on the CPU type.

Table 3-1
CPU type Number of AR_SEND instances
CPU 410 64
CPU 417 64
CPU 416 32
CPU 414 16
CPU 412 4
From WIinAC RTX 2010 32
Note For current information about the various CPUs and the AR_SEND instances,

please refer to the

"SIMATIC S7-400 Automation System S7-400 CPU Specifications" manual.

Fast archiving of process
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3 Basics

3.3

3.3.1

Functionality of the block ARSCAN_E
Overview / Function

This chapter describes the block ARSCAN_E in detail.

Figure 3-2

ARSCAN E

ARSCAN E

ARSCAN E
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The block ARSCAN_E detects a process value of the data type REAL or DWORD
and the associated quality code. To do this, the block is connected in the CFC
editor to the corresponding channel block (e.g. Pcs7AnIn) or another data source.
The ARSCAN_E block is called up in the acquisition cycle of the process value
(e.g. according to the channel block).

Each ARSCAN_E block is connected to an AR_MAN_E block, whereby an
AR_MAN _E block can connect to several ARSCAN_E blocks.

Process values of the REAL data type require process value limits to be set at the
input parameters ULRANGE and UHRANGE.

The acquired process value is checked for validity ("QC_VALUE" quality code)
and modification.

Value changes to REAL data types are identified when the process value has
changed by a certain percentage when compared to the last measured process
value. This change can be set by the user by means of a percentage value based
on the measurement range (DEADBAND).

With respect to the DWORD data type, binary change monitoring is achieved,

i.e. the input parameter DEADBAND is ignored.

Depending on the parameter assignment of the ARSCAN_E block, one can
distinguish between two different criteria for storing a process value.

The following sections describe the two types in detail:
e Cyclic process value detection
e Event-driven process value detection

Fast archiving of process
Entry ID: 23780904, V2.2, 08/2016 11
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3 Basics

3.3.2

Note

Note

Note

3.3.3

Note

Note

Cyclic process value detection

The cyclic process value detection can be used for the data types REAL and
DWROD. The following settings are required.

e Input parameters:
- DEADBAND=0
- MIN_CYC adjust accordingly
- MAX_CYC adjust accordingly

It is important to ensure that MAX_CYC > MIN_CYC, otherwise an error is
generated.

Output (of the block ARSCAN_E) QPARA_ER = TRUE

This enables the process value to be saved as a constant bus cycle time
(MIN_CYC).

Note that the minimum cycle time is limited by the cycle in which the ARSCAN_E
block is called up.

By constantly saving process values, the amount of data can become very large
(especially when the cycle time is low).

The security level 1 is disabled: Double DEADBAND.

Event-driven process value detection

The event-driven process value detection can only be used for the data type REAL.
The following settings are required.

e Input parameters:
- Set ULRANGE / UHRANGE (measuring range)
- Set DEADBAND (change in percent for archiving)

Therefore, the process value is stored if the value change in percent for the last
cycle is greater than or equal to the value of the input parameter DEADBAND.

The event-driven storage of the process values results in a reduction of data
traffic, when compared to the cyclic process value detection.

The security level 2 is disabled: Increase the archiving cycle to MAX_CYC.

Fast archiving of process
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3.34

Note

3.3.5

Saving process values

The block AR_MAN_E allocates FIFO memory for the process values.

The block ARSCAN _E stores the collected process data in this memory.

To do this, these two blocks are connected to each other via an interconnection
that provides all the necessary information about the memory area.

If the conditions for storing a process value are met, the block ARSCAN_E writes
the process value with the current timestamp in the FIFO memory and then
increments the write pointer of the FIFO memory so that it points to the next free
space.

You can find a detailed description of the block AR_MAN_E in the next chapter.

After saving a process value, the output QNUM_TRANS is incremented by
the value 1.

The allocation of the FIFO memory can be read from the output QFIFODEG.

Responding to overload or connection failure

If the FIFO of the block AR_MAN_E is too full, the amount of data to be stored is
automatically reduced (security level 1, security level 2). This function is described
in detail in chapter 3.4.3 Responding to overload or connection failure.

Fast archiving of process
Entry ID: 23780904, V2.2, 08/2016 13
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3.3.6 Block 1/Os

Input parameters

Table 3-2
Parameter Data type Description
EN BOOL Activates block processing
(hidden)
Standard value: 1
ENABLE BOOL Activates the detection of the process values.
(hidden)
Standard value: 1
RUNUPCYC INT Number of block cycles before starting.
(hidden)
Standard value: 5
SAMPLE_TIME | REAL Cycle time of the cyclic interrupt OB in which the block
(hidden) is called.
Itis set by the compiler.
SUB_ID WORD AR_ID subnumber for the assignment of the process
value to an archive tag in a process value archive.
Allowed values: 1 - 4095
ULRANGE REAL Lower limit of the measuring range
(only relevant for process values of the data type
REAL).
Standard value: 0.0
UHRANGE REAL Upper limit of the measuring range
(only relevant for process values of the data type
REAL).

Standard value: 100.0

DEADBAND REAL Minimum change of the process value (in percent) from
the previous value, for it to be stored

(only relevant for process values of the data type
REAL).

Standard value: 0.5

Remark:
The percentage refers to the parameters ULRANGE
and UHRANGE

MIN_CYC REAL Minimum detection time (in seconds).

Standard value: 0.0

MAX_CYC REAL Maximum detection time (in seconds) of the process
value (archived, even if change < DEADBAND).

Standard value: 5.0

Note: MAX_CYC > MIN_CYC otherwise an error is
generated -> Output QPARA_ER = TRUE

UPD_EVT BOOL Edge triggering of an archiving process.

Fast archiving of process
Entry ID: 23780904, V2.2, 08/2016 14



© Siemens AG 2016 All rights reserved

3 Basics

Output parameters

Parameter Data type Description
UPD_COND BOOL Condition triggering of an archiving process.
(hidden)
VALUE ANY Process value to be archived.
Only values of data type REAL and DWORD are
allowed.
QC_VALUE BYTE Quality code of the process value
(must be interconnected or have its parameter assigned
with 16#80).
PTR STRUCT | Interconnection with AR_MAN_E block.
Provides information for ARSCAN_E and a pointer to
the FIFO memory.
Table 3-3
Parameter Data type Description
ENO BOOL Block processing is activated.
(hidden)
QSTATUS WORD Status word for the block.
QNUM_TRANS INT Number of archived process values.
QUPD_EVT BOOL It is set for one cycle if the block writes to the FIFO
(hidden) memory of the AR_MAN_E block.
QPARA_ER BOOL Wrong parameter assignment of the block.
QCONN_ER BOOL Incorrect interconnection of the input parameter VALUE.
QBAD_QC BOOL Quiality code of the process value is poor. No archiving
of the process value.
QALARM_1 BOOL Security Level 1 has been reached
QALARM_2 BOOL Security Level 2 has been reached
QFIFOFUL BOOL FIFO memory of the module AR_MAN_E is full. It is not
possible to archive the process value.
QFIFODEG INT FIFO memory allocation in %
QARC_LOK BOOL Archiving at the block AR_MAN_E is deactivated.

Fast archiving of process
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Allocation of the status word QSTATUS

Table 3-4
Bit Byte Description
0 QC = 16#00
1 PTR invalid or not connected
2 VALUE not connected
3 2 VALUE has a wrong data type
4 Q%‘ Security Level 1 reached
5 Security Level 2 reached
6 FIFO memory allocation is too high (FIFO full)
7 Archiving lock of AR_MAN_E active
8 AR_ID-Subnummer < 1
9 Invalid parameter assignment of MIN_CYC & MAX_CYC
10 Parameter assignment of DEADBAND is incorrect (< 0% or > 100%)
11 ‘; ULRANGE = UHLRANGE
12 % Not used
13 Not used
14 Not used
15 Not used
Fast archiving of process
Entry ID: 23780904, V2.2, 08/2016 16
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3 Basics

3.4

3.4.1

Note

Functionality of the block AR_MAN_E
Overview / Function

This chapter describes the block AR_MAN_E in detail.

Figure 3-3
AR_MAN E
R 0B35
e 2/2
1641 [AR_ID 0STATUS [—
10—{5HD_FILL QSND_ENT|—
L.0—{smp_cve 0PARL FR|—
75— ALERT 1 QSEND_ER|—
85| ALERT 2z QFIFOFUL [
0—{ sHp_EVT QFIFODEG|—
ONUMSEND |
QNMCON |—
QPTR|—

The block AR_MAN_E manages the memory area of the process values and sends
the data to WinCC via AR_SEND.

Due to the CPU-dependent limitation of AR_SEND instances, only one instance

of the AR_SEND block is used per AR_MAN_E block instance.

An AR_MAN_E block can manage up to 4095 ARSCAN_E blocks

(4095 AR_ID subnumbers are possible per AR_ID). This allows multiple process
values to be detected and sent to WinCC with an AR_MAN _E instance. However,
the actual number of ARSCAN_E blocks is reduced due to the resulting data traffic
and the individual application.

A transmission is started when:

e The FIFO has reached the configured memory allocation
e The configured time for the transmission has elapsed

e A send operation has been manually triggered

If a send operation is triggered, the process values are sent to WinCC using an
AR_SEND call.

The FIFO memory allocation is displayed at the output QFIFODEG.
The output QNUMSEND indicates the number of data blocks sent.

The output QNUMCONNECT indicates the number of connected ARSCAN_E
blocks. The counting takes place only in the startup characteristics of the block
and therefore, the control system must be restarted for the output to be updated.

Fast archiving of process
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3.4.2

Used AR_SEND format

The AR_SEND format 9 (Header Type = 9) is used for the transfer.
This format allows the transmission of values with individual time stamps and
different AR_ID subnumbers.

26 bytes are needed in the frame for a 4-byte value (REAL / DWORD).

Table 3-5

Headertype = 9

Year Month

Day Hour

Minute Second

1/10s 1/100s 1/1000s Day of the week

22 bytes

Cylce =0

AR_ID subnumber

Data type of the process data

Number of process values

Process value

4 Byte

CAUTION

The parameter AR_ID is only evaluated when the program starts.
You cannot change the AR _ID subsequently during operation.

3.4.3

Note

Responding to overload or connection failure

When the AR_MAN_E block is overloaded or in case of connection problems with
WinCC, more process values are written to the memory than can be read from it
and sent to WIinCC. To delay the filling up of the memory, 2 programmable security
levels have been created.
e Security Level 1 (input parameter: ALERT_1 in %)

- The ARSCAN_E block doubles the input parameter DEADBAND internally.

Security Level 1 only functions with process values of the data type REAL.

e Security Level 2 (input parameter: ALERT_2 in %)

- The ARSCAN_E block increases the logging cycle to MAX_CYC.

Despite these measures, it may happen that the allocation of the FIFO memory
increases to 100%. In this case, no new process values are stored until the
memory usage drops again.

In general, one must ensure that the quantity structure of the process values
remains manageable.

Fast archiving of process
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3.4.4 Block 1/Os

Input parameters

Table 3-6
Parameter Data type Description

EN BOOL Activates block processing.

(hidden)
Standard value: 1

ENABLE BOOL Activates the detection of the process values.

(hidden)
Standard value: 1

RUNUPCYC INT Number of block cycles before starting.

(hidden)
Standard value: 5

SAMPLE_TIME REAL Cycle time of the cyclic interrupt OB in which the block

(hidden) is called.
Itis set by the compiler.

AR_ID DWORD Archive number for the assignment of an AR_SEND
instance to an archive tag.
It is set by the compiler.

SND_FILL INT Allocation of FIFO memory required in % to initiate
a transmission.
Standard value: 10

SND_CYC REAL Transmission cycle
After this time, the send operation is initiated with the
available data.
Standard value: 1.0

ALERT_1 INT Allocation of FIFO memory required in % to activate
the security level 1.
Standard value: 75

ALERT_2 INT Allocation of FIFO memory required in % to activate
the security level 2.
Standard value: 85

SND_EVT BOOL Edge triggering of a sending process.

Fast archiving of process
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Output parameters

Table 3-7
Parameter Data type Description
ENO BOOL Block processing is activated.
(hidden)
QSTATUS WORD Status word for the block.
QSND_EVT BOOL Is set for one cycle if a sending process was triggered.
QPARA_ER BOOL Wrong parameter assignment of the block.
QSEND_ER BOOL An error has occurred when processing the internal
block AR_SEND.
QFIFOFUL BOOL The FIFO memory is full. It is not possible to archive the
process value.
QFIFODEG BOOL FIFO memory allocation in %
QNUMSEND INT Number of data blocks transmitted
QNUMCONNECT | INT Number of connected ARSCAN_E instances
QPTR STRUCT Interconnection with ARSCAN_E
Provides information for ARSCAN_E and a pointer to
the FIFO memory.

Allocation of the status word QSTATUS

Table 3-8

Bit Byte

Description

FIFO is full, Archiving is locked

AR ID<1

ALARM_1 > ALARM 2
Or one of both = 100
Or one of both<0

Byte O

SND_FILL:
> ALARM_1
> ALARM_2
> 100

<0

SND_CYC <0

Not used

Not used

Not used

N OO

Not used

Byte 1

Not used
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4.2

Configuration

Preliminary remarks

The following section describes the configuration steps necessary to deploy the
solution.

Basic configuration steps, such as creating a project, configuring the stations and
their hardware, configuring the connections, etc. are not described in this
Application Example.

An example project has been created and can be downloaded for testing purposes
and to experiment with the solution. The chapters 5 Example project and

6 Operation of the example project contain information about the concrete use

of the example project.

The screenshots and descriptions in this chapter have been prepared on the basis
of the example project and serve to illustrate the basic procedure.

Important points before configuring

In order to ensure that the solution does not reach its limits, you must take some
points into consideration before you start configuring the fast process value
archiving for your application.

e Calculate the quantity structure of the process values to be archived carefully.

e Do not archive the values in cycles that are faster than necessary as this would
increase the data traffic unnecessarily.

e Take note of the maximum usable number of AR_SEND instances per CPU,
as described in Chapter 3.2Functionality of the block AR_SEND (an
AR_MAN_E block instantiates an AR_SEND block).

e Take note of the limits of communication to WinCC as described in chapter
3.2Functionality of the block AR_SEND Should it be likely to come close to
these limits, you should look at the issue in detail and calculate your quantity
structure carefully.

e Test your quantity structure in advance. For example, with a project like the
one shown this Application Example.

e Please note that, for example, the use of a CAS (Central Archive Server) / PH
(Process Historian) for archiving long-term relevant archive tags can restrict the
performance of the system and thus the quantity structure for fast archiving of
process values.

e Consider that even the processing time of the complete S7 program plays
arole.

e  Other communications (e.g. Modbus communication, OPC communication at
the OS level, etc.) must be also taken into consideration.

e Make sure that the time synchronization works properly in your system, as for
example, time differences between the AS and the OS can lead to problems.

¢ Make sure that the communication load increases with redundant systems, or
that the limits of communication to WinCC decrease.

e Itis recommended to define a workaround on how to handle the stopping and
starting of the OS runtime in combination with the fast process value archiving.
For example, start archiving only when the OS Runtime is fully started and end
the archiving before the OS runtime is stopped.

Fast archiving of process
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CAUTION

Please note that no monitoring takes place during communication with
redundant OS servers, whether there is connection to both servers or not.
The AR_SEND system block only reports an error when the connection to
both servers is interrupted.

As a general rule, it is therefore recommended that when using redundant
OS servers you define connection monitoring and a corresponding
workaround.

In summary, it can be said that there are many factors that affect the performance
of the fast process value archiving. One must always consider the entire
environment.

For larger quantity structures, it is advisable to test in advance to see whether they
work on a general scale.

CAUTION

Should there be any unexpected difficulties with the fast process value
archiving, check the entire environment.

Consider that there may also be problems with the network traffic on the
system bus that affect negatively.

Fast archiving of process
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4.3 Configuring in SIMATIC Manager

To use the solution you need the blocks ARSCAN_E and AR_MAN_E in your
project. There are two ways of doing this, as described below.

Besides this, you must then configure the modules according to their requirements.

4.3.1 Integrating module ARSCAN_E and AR_MAN_E in the PCS 7 project

Importing the block

1. Import the blocks ARSCAN_E and AR_MAN_E from the example project into
the master data library of your project.

Be sure to also import the AR_SEND block, because it is used by the
AR_MAN _E block.

2. Adjust the block numbers (e.g. FB672 to FBxxx),
if this is required by your project.

Note To import blocks, it is recommended to do the following:

1. Alibrary serves as a source for the block.

2. Place a Continuous Function Chart into the project (or library)
where you want to import the blocks.

3. Search the Continuous Function Chart catalog for the library
with the blocks that you want to import and drag it into the
Continuous Function Chart.

This way you ensure that all required blocks are also imported and the entries
are created in the symbol table.

Generating blocks from the SCL sources
To create the blocks from the SCL source files, proceed as follows:

1. Import the SCL source files into your master data library.
2. Create the icons for the blocks in the symbol table:
e FB 672 as ARSCAN_E (or another block number if necessary)
e FB 673 as AR_MAN_E (or another block number if necessary)
3. Import the block AR_SEND into your master data library.
4, Compile the SCL source files.

Fast archiving of process
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4.3.2 Configuring AR_MAN_E

1. Place an AR_MAN_E block for each AR_ID that you want to use.
It is up to you whether you want to archive all your process values with the
same AR_ID or split them into several different ones.
It would be conceivable to divide the process values according to subsystem,
technological functions, archiving cycles, etc.
Consider limiting the AR_ID subnumbers (and thus the archive tags) per
AR_ID (4095 AR_ID subnumbers per AR_ID).

2. Set the remaining parameters and interconnections to the block according to
your requirements.

Figure 4-1
Scan 02
LRSCAN E T
ARSCAN E 5/7
ENAELE QSTATUS |—
lagz |SUB_ID QNUM_TRA [—
0. 0— ULRANGE QPARL ER —
100. 0— UHRANGE QCONN_ER [—
1. 0—DEADEAND QBAD QC [—
0.2—MIN_C¥C QALARM 1|—
5.0 |MAX CYC QALLRM Z —
0— UPD_EVT QFIFOFUL [—
QC_VALUE QFIFODEG —
TR QARC_LOK [—
VALUE
Archive
LR MAN E
AR, MAN E 5/8
ENAELE QSTATUS |—
16§l |AR_ID Q5ND_EVT [—
10— SND_FILL QP4RA ER —
1.0—SND_CYC QSEND_ER [—
75— ALERT 1 QFIFOFUL —
55— ALERT_& QUFIFODEG [—
0— SHD_EWT QNUMSEND —
QNUMCONN [—
QFTR.
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4.3.3 Configuring ARSCAN_E

1.

Place an ARSCAN_E block for each process value (archive tag) that you want
to archive.

Connect the input parameter VALUE to the source file of your process value.
Please note that only the data types DWORD and REAL are permitted. If your
process value is not of the correct data type, make sure that you perform a
correct data type conversion.

Connect the input QC_VALUE with the quality code of the process value or
assign it the value 16#80 (valid value).

Connect the input PTR to the output QPTR of the AR_MAN_E block, which
creates a connection to the WinCC process value archive.

Ensure that the blocks have the correct execution sequence.

By default, the ARSCAN_E blocks should run after other blocks from which
you access process values and after the AR_MAN_E block, to which they are
connected.

Set the remaining parameters and interconnections to the block according to
your requirements.

Figure 4-2
STRUCT_R_1 Soan_0L1
Strudnln ARSCAN_E
Separati ARSCAN E
n [T Value * ENABLE QSTATUS [—
5T 16#1 |SUB_ID QNUM_TRA[—
0. 0— ULRANGE QUPARA_ER|—
100, 0— UHRANGE QCONN_ER|—
1. 0—| DEADBAND QBAD_QC [—
PY_L 0. 0— MIN_CYC QALARM 1|—
PcsTAnin [ 5.0 |MAX_CYC QALARM z|—
Analoy 1 0— UPD_EVT QFIFOFUL [—
PV_In Bad|— 9C_VALUE QFIFODEG|—
100.0—{3cale PY_ut FTR QARC_LOK|—
1001— PV_InUni PY_Outln[— VALUE

1—{Sim0n Scalelut [—
SinP¥_In Ooshct—
0.0— 5ubsPV_I
0— M5 _Relea
leg0— N3
lego— Mode
leg0— Dataxchyg

CAUTION  All configured AR_ID subnumbers must be configured in WinCC.

If WinCC detects an AR_ID subnumber, which is not configured, it stops
the interpreting of user data.

Note To see if your configuration works, for example, in order to ensure the
completeness of the archives in case of large quantity structures, it is advisable
to provide a simple signal (e.g. "sawtooth" function) and to optionally
interconnect this with the ARSCAN_E blocks (e.g. as a simulation value at the
channel block, such as indicated in Figure 4-2).

Therefore, for commissioning you can archive the test signal. Export the archive
data via WinCC and, for example, analyze it in Microsoft Excel.
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4.4

441

Configuring in WinCC

To save archive tags, you must create at least one process value archive.

Itis up to you, whether you want to create your own process value archive for each
configured AR_ID and each configured AR_MAN_E block.

Depending on how the process values to be archived are split, this could be quite
useful, for example, to achieve a separate storage of the database segments or

to ensure a clear arrangement of the project.

Creating a process value archive

1. Open the WinCC Tag Logging in WinCC Explorer.

2. Click on "Archives > Process Value Archives" and create a new archive.

3. Click inside the field marked with the asterisk in the column "Archive name"

and enter an appropriate name.

4. Configure this archive to your needs.

5. The process value archive has been created.

To create more process value archives, repeat the mentioned steps.

Example project

In the example project, a process value archive was created with the name

"FastArchive".

Figure 4-3

Iii Tag Logging - WinCC Configuration Studio

File Edit View Help

—lolx]

Fast archiving of process
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Tag Logging Archives [ Process Value Archives ] |rj( # ~| | Properties - Process value archive »
& | Tag Logging Archive name Comment \Archiving disabHManuaI input permit « || 2 |Selection
© Timers 1 [FastArchive [&] Object type Process value archive
=+l Archives 2 Object name FastArchive
=-JJ] Process Value Archives | ——| & |General
] FastArchive 3
+-J1J Compressed Archives 4 Commperiy
T Archiving disabled
— Manual input permitted Ei
L6 Last change 08.07.2013 15:21:09
L7 & |General archive properties
i Archive name FastArchive
[9] Action at archive start/enable|
10 & [Memory location
T Memory location Hard disk
12 Size in data records 100
[13] Size in kB/tags 3
|14
,,,,, [15 |
1i] Tag Management 16|
[ Alarm logging 17
18
171 Tag Logging Y —
Text Library 20|
— 21 =
#il 5 0 117050 Process Value Archives [T« | Y
Ready English (United States) Table: 1 Process value archive | 100 % (=) v} (%)
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4.4.2 Applying archive tags

Create an archive tag for each process value you would like to archive.
Should you have chosen to use several process value archives, perform the steps
in the process archive, to which the tag is to be assigned.

Create a new archive tag.

Click on the archive (Example: "FastArchive™) and then on the "Process
Controlled Tags" tab.

Click inside the field marked with the asterisk in the column "Raw data tags"
and click on the button L=

In your S7 program, select the raw data type for archives
"[Program name]#RawArchive" and confirm with "OK".

Figure 4-4

HiF Tag Logging - WinCC Configuration Studio
File Edit View Help

Tag Logging « | Archives [ FastArchive ] Process-controlled tags [Find P~
=) Tag Logging Raw data tag Tag type Archive tag name Tag name =
A :’“:“ 1 |FastArchPgmi#RawArchiv Process #FastArchPgmi#RawArchiv#A#00000001#0001
=44 Archives T
=1 Process value Archives 2]
1] Fastarchive [3 | ‘ \
-J3] Comy < 4
u '”55% N = Tag selection e
) 5 3 e T
o Filter: -
1 7 5 STEP 7 Symbol Server Name 1l
el 5 ES Variables ZiFastArchPgm#RawEvent R
= £-€J WinCC Tags FastArchPgm#RawArchiv i
g § internaltags ‘E: FastarchPgm/@CPU_RT/@ A
10 -1 List of al structure instances £ FastArchPgm/@(8)/SIMATI H
11 4 st of al ags ‘ E FastArcthg/HMIconneclrL FYstart F
12 = g iM:o]gtcPﬁ Protocol Sute “E FastArchiving/HMIconnection ving F
13 i E: FastArchiving/HMIcennection/DisableTestSig F|
14 < I named Connectons ‘E: FastArchPgm/@PA_CPU/@PA_CPU F
14 | 04 FastArchPgm + FastArchPgm/@PA_CPU/@PA
15 +- |l Industrial Ethernet (I1)
16 PROFIBUS (I}
7l TCP/IP
= 1l SbtpPLC
18 -l Industrial Ethernet
19 M PROFIBUS
..... 20 M w1
1l Tag Management 21 < | i
. 22
Alarm logging P2 Apply oK cancel
= 5 I I |
1| Tag Logging 4] ‘ o
Text Library 25 u
26 NV ~
7|\ 4 » | Tags | Process-controlled tags,. [T] | »

| Table: 1 Process-controlled tag | 100 % (=

Ready | @ Gh (United States)

=

Select an appropriate DLL normalization format for the process tag to be
archived.

Figure 4-5
Archives [ FastArchive ] Process-controlled tags
\Raw data tag Tag type \Archive tag name \Tag name \Archive name Format DLL Relev
1 ‘FastArcthm#RawArchiv Process #FastArchPgm#RawArchiv#A#00000001#0001 FastArchive pemcTome ol
2 FastArchPgm#RawArchiv Process FastArchPgm#RawArchiv FastArchive -
3
4 S5STD.NLL
5
6
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Note

Note

10. Select the cell in the "Tag name" column and click on the button L™~
11. Assign the AR_ID and the AR_ID subnumber according to your configuration

in the Continuous Function Chart and click the "OK" button.

Figure 4-6
ne Tag name Archive name Format DLL Re
#FastArchPgm#RawArchiv#A#00000001#0001 FastArchive nrms7pmc.nll
|Fastarchpgm#RawArchiv _ |.)stArchive nrms7pmc.nil
(o By
w S 2 B
ARJD\\l\ hex
(A

[+ Subnumber

AR_ID-Subnumber ‘? hex
[1.
A

&

If you have decided to use multiple process value archives, be careful to make
the correct selection when creating an archive tag and the correct allocation of
AR_ID and AR_ID subnumbers.

12. If your archive tags are to be stored in a long-term archive, activate the "long-

term relevant" option.

Figure 4-7

mat DLL Relevant long term @
is7pmc.nll ]

is7pmc.nll

Please note that, for example, the use of a CAS (Central Archive Server) for
archiving long-term relevant archive tags can restrict the performance of the
system and thus the quantity structure for fast archiving of process values.
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13. (Optional) Allocate an archive tag name.

Note If you leave this field blank, it is used as an archive tag name for the tag name.
This is, for example, clear in WinCC when selecting tags for a trend control.

EH Selection of Archives/Tags ird B

Hierarchy: I FastArchivel

- £ PCS7 Tag name
*JI1 FastArchive *
() #FastArchPgm#RawArchiv#A#00000001#0001
ZJValue02
‘ | 2

o | Cancel | Help |

Example project

In the bundled Application Example, two archive tags have been created in the
process value archive "FastArchive". No archive variable name has been assigned
to the first one, whereas Value02" was chosen as the name for the second one.

Figure 4-8
[ Tag Logging - WinCC Configuration Studio -3 LI
File Edit View Help
Tag Logging « | Archives [ FastArchive ] Process-controlled tags [Find Pl «
=] Tag Logging Raw data tag ‘Tag type ‘Archive tag name |Tag name Archive name || bl
Ijuf“m:“ 1 |FastArchPgm#RawArchiv \Process #FastArchPgm#RawArchiv#A#00000001£0001  FastArchive =
e Archives 2 [FastArchPgm#RawArchiv 1 ocess Value02 #FastArchPgm#RawArchiv#A#00000001#0002  FastArchive g
&-J1] Process value Archives =
-1 FastArchive 3 H
131 Compressed Archives [ 4]
L5
6
L7
'8
"' Tag Management 19| e
= Alarm loggin 10
logging 11
111 Tag Logging 12
Text Library 13
— 14 -
il 3 0 -] Tags | Process-controlled tags [[«] | »
Ready | English (United States) | Table: 2 process-controlled tags | 100 % (=) } @)
Note Make sure that a corresponding archive tag is created for every AR_ID and

AR_ID subnumber that was configured in the AS program.

14, Repeat the previous steps to create additional archive tags.
15. Save and exit the WinCC Tag Logging.
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4.4.3 Further configurations

The necessary configuration steps are now done.

Additional configuration steps in connection with the fast process value archiving
could include the following:

Add trend controls and table controls in WinCC pictures for the visualization
and simple export of archived process values.

Configuring the backup configuration if the long-term relevance has been
configured.

Configuring a disconnection of the fast process value archiving before the
WinCC runtime is exited or an activation of the archiving after starting the
WinCC runtime.

This can increase the plausibility of the archived process values, as there is
a clear division and therefore an assignment to stop and start the WinCC
runtime.

In addition, it also ensures that the buffering of process values does not fill up.
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5 Example project

The example project shows the basic configuration of the fast process value
archiving.

The project was created as a single-user system. The configuration of the
automation hardware corresponds to a real system and has been tested with it.

As a quick introduction, the example project was prepared for use with S7-
PLCSSIM.

The following descriptions refer exclusively to the use of the example project with
S7-PLCSIM. If you want to use real hardware, the following changes must be also
carried out:

Note

Adapt the access point in the SIMATIC Manager
Adapt the hardware configuration of the PC station
Adapt the hardware configuration of the AS

- If you want to use a different CPU, make sure to use the function "Replace
object...". If you delete the CPU and paste another, you would lose the S7
program.

You might need to adjust the network adapter in the system properties of the
WinCC channel driver.

The example project was created with PCS 7 V8.2.
If you are using a newer version of PCS 7, you must update the project.

If you are using a version prior to PCS 7 V8.2, you cannot use this example
project.

In this case, you can fall back to the SCL source files of the blocks ARSCAN_E
and AR_MAN_E and reproduce the sample configuration from the following
descriptions.

However, not every aspect of the project creation is addressed.

If in doubt, refer to the online help and documentation.
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51 Adjusting the example project

Retrieving the SIMATIC PCS 7 project

1. Download the example project and copy it to your Engineering Stati
2. Open the SIMATIC Manager, retrieve the project and open it.

Adjusting the Single Station
3. Match the name of the PC station to your computer name.

on.

4. Open the hardware configuration of the PC station and match the IP address to

that of your computer.

Figure 5-1
_ SIMATIC Manager - FastArchiving_MP _ o] x|
Fle Edit Insert PLC View Options Window Help
D227 | % B |dn[o 2% = 5@ & |[<NoFiter> % BE mEMm(
o) FastArchiving_MP (Component view) — D:\Projects\FastArch\Fast_MP _ |EI |i|
E@ FastArchiving_MF Ohbjectname Symbalicname | Type | Size | Author
F—‘ @ Fastarchiving_Prj Al Configuratio PC station configu... —
- =-E SIMATICA0001) . Wi T Appl. WinCC Application —
o-[@ oPU a10-5H 4 E General @ ; op -
Sz EactirchPom
eamPAl
[ =T =T =T g W= 3
- @ Fasthrchiving_ 3
L | i
Press F1 to get Help. [ |PC internaldocal. 1 Y
Figure 5-2
Properties - Ethernet interface IE General (R0/S2) il
" General Parameters |
[~ SetMAC address / use ISO protocol
MAC address: I
¥ IP pretocslis being used
IP address: [0:10.040 Gateway
(@ Do notuse router
Subnet mask: [255.255.255.0
 Use router
Address: I
Subnet
- not networked — MNew...
Properties... |
Delete |
o |__tob_|
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5. Save and compile the hardware configuration.
6. Open the dialog to configure the PC station.

Figure 5-3

W SIMATIC Manager - FastArchiving_MP — |EI |i|
Fle Edt Insert PLC View Options Window Help

D& |87 &% Bie|dl = %2 =&

& [ <No Fiter> % e =Ems

2 FastArchiving_MP (Component view) — D:\Projects\FastArch\Fast_MP - Ellil
E-@ Fastirchiving_MP Object name Symbolic name | Type | S\zel Author
= 8P FastArchiving_Prj @l Configuration — PC station configu.. —
5l SIMATIC 400(1) WinCC Appl. — WinCC Application —
=- @ cPU4105H 48| General — cP —

FastArchPgm

Qpen Object Ctri+Alt+0

Cut Ctri+X

Copy Ctri+C

Paste |+ _,I

Configure...

Access Protectiol
o n Compile and Download Objects...

Print

Compare...

Rename F2
Object Properties... Alf+Return

Configures a selectable target computer according to the structure or the selected PC station (initial/reconfiguration) Y

7. Configure your PC station.

x

Local network, connection:

ILcu:aI Area Connection j
Accezsible computers: ﬁl
TEAMPAD

¥ Use configured computer name

Target computer:
[TeamPAQT

Dizplay. .. |

Mezzages:
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Adjusting the AS

8. Open the hardware configuration of the AS and modify the IP address of the
Ethernet interface of the CPU so that it connects to the same network as your
PC station.

Figure 5-4

_ SIMATIC Manager - FastArchiving_ MP _ ||:| | il
Fie Edit Insert PLC View Options Window Help

D=2y = e %" & |[<No Fiter> % eE mEM(W

) FastArchiving_MP (Component view) -- D:\Projects\FastArch\Fast_MP — |EI |i|
E-@ Fastirchiving_MP Symbolic name Size | Author
=8P FastArchiving_Prj B i
SIMATIC 400(1) ECr —

CPU 410-5H
#1-50 FastArchPgm
& TeamPAl

{:I Shared Declarations
- FastArchiving_Lib

‘ | [

|PC internal.ocal.1 4

Press F1 to get Help.

Figure 5-5

Properties - Ethernet interface PN-IO-X5 (R0/S3.5) x|

General Parameters |

IP address: [10.10031 St
@ Do notuse router
Subnet mask: |255255255|J
 Use router
Address: I
Subnet
- not networked — New...

Properties... |
Delete |

el | __vop_|

9. Save and compile the hardware configuration.
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Compiling and loading the changes
10. After the necessary adjustments have been made, they must be compiled and

11.

12.

13.

14.
15.

loaded.
Open NetPro.

Figure 5-6

_ SIMATIC Manager - FastArchiving_MP i ] F3
Fle Edit Insert PLC View Options Window Help

D82 &% B da[o %] % = | & |[<No Filter> S| e|lE mEme
2 FastArchiving_MP (Component view) — D:\Projects\FastArch\Fast_MP m @ _ |E| |L|
=88l FastArchiving_tdP Size | Author

Symbolic name
=88 FastArchiving_Prj Bl i i

ire ol
SIMATIC 400(1) CPU 410-5H — CrRU —
- @ cPU4105H
-5 FastarchPgm
& TeamPAN
-1 Shared Declarations
- FastArchiving_Lib

y | [

Press F1 to get Help. \ |PC internalocal.1 y

Figure 5-7
;}_% NetPro - [FastArchiving_Prj (Network) -- D:\Projects\Fasi ;lglil
88 network Edt Insert PLC View Options Window  Help ==
SH (S 0 L Bl
TeamPAO1
g WinCC | E
Appl. | Genera
I
=]
PlantBus
Industrial Ethernet
SIMATIC 400(1)
CPU  'MPUDP ! PN-ID
4163 ! :
PNDP
‘il
2
< | v
| Ready [PCinternallocal.l

Compile the NetPro configuration with the option "Compile and check
everything".

Load the configuration to the PC station, by highlighting it and selecting "Target
System > Download to Current Project > Selected Station" and follow the
dialog.

Open PLCSIM by clicking on "Extras > Simulate Modules".

Load the configuration in the AS.

Load the program in the AS and start PLCSIM.
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Note If you can't load the stations, check your configuration:

e Network configuration (network cards, IP addresses, firewall, switches, etc.)
e Check the configuration in the project.

e Carry out the steps for configuring the PC station once again.

Adjusting the Operator Station
16. Open the WInCC project.

17. If your computer name is different than that of the example project, you will get

the following message:

"The configured server is not available. Would you like to open the project with

the local computer as the server?"

Confirm this message by clicking "Yes".

Figure 5-8

sTomwinx

The configured server is not available. Do you want to open the
é ! . project with the local computer as server?

18. Adjust the computer name in the WinCC project.
For this, select the "Computer" option on the left side and open the properties

dialog of the configured computer.

Figure 5-9
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5 Example project

19. Set the computer name.

Figure 5-10
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20. Restart WinCC Explorer for the change to take effect.
21. Compile the OS. A change compilation is sufficient.

The necessary changes are now in place. You can now start the WinCC runtime
and test the fast process value archiving.

Note If the WinCC runtime cannot connect to PLCSIM, please check your
configuration.

Also check whether the correct network adapter is selected in the system
parameters of the WinCC channel driver.
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5 Example project

5.2

AS section

Description of the example project

The AS project contains a three-hierarchy folder. The OS area begins at the
second hierarchical level.

e Plant

- This folder serves as a central point to establish the assignment of the
lower-level folder to the AS.

e FastArchiving

- This folder contains the program for fast process value archiving and the
picture for the OS project.

The following sections only discuss the Continuous Function Charts in the
hierarchy folder "FastArchiving".

Fast archiving of process
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5 Example project

Tabelle 5-1

CFC Chart Name

Functions

TestSignal

The chart includes block for generating and controlling of two
simulated values and will be called in OB35 (100ms cycle).

The chart contains the following blocks:

e  2x“OpDi01” for starting/stopping and resetting of the real value
simulation on the OS

e 1x “TimerP” for the automatically cancelling of the RESET-Signal
e  2x “SIM_REAL_VAL" for the simulation of the REAL values

The simulation blocks of the real values can parametrized with the
following Settings:

e Simulation mode: Sawtooth or Sinus wave
e  Min/Max limits
e  Frequency (Counts per second)

ArchiveExample

This chart includes the example of the fast archiving and will be
called in OB35 (100ms cycle).

The chart contains the following blocks:

e 2x “Pcs7AnIn” for the acquisition of the process values

e  2x,MonAnS* for the monitoring of the process values on the OS
e 2x,StruAnIn® for separation the APL signal structure

e 2x,StruScIn® for separation the APL scale structure

e 1x,0pDi01* for starting/stopping of the archiving on the OS

o 2x ,ARSCAN_E* for the acquisition of the archiving values

¢ 1x,AR_MAN_E*fort he fast archiving

The blocks for the fast archiving are as follows parameterized:
e "Scan01" block

This block has been configured to detect the process value in
an event-driven manner but at least after 5 seconds.
SUB_ID=1

DEADBAND =1

MIN_CYC =0

MAX_CYC =5

Since the test signal can accept the values 1 - 100 and each
cycle changes by the value 1, each individual value from the
test signal is also archived. If the test signal is not active, the
value is archived every 5 seconds.

e "SCAN_02" block
This block has been configured to detect the process value

cyclically.

SUB ID=2
DEADBAND =0
MIN_CYC =0.2

MAX_CYC =5.0
The UPD_EVT parameter has been connected to the signal to
start archiving, so that even the first value in the data series is
archived.
Thanks to the cyclic archiving every 200ms, every second
value of the test signal is archived.

e "Archive01" block
This block is connected to the two ARSCAN_E blocks and
parameterized with AR_ID = 1. The other parameters were left
at their default settings.

Fast archiving of process
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5 Example project

OS section

The WIinCC Tag Logging has been configured as described in Chapter 4.4

Configuring in WinCC.

The picture "FastArchiving" in the hierarchy folder that carries the same name
contains some elements to control the sample program, and to display the archived
values and export them if required.

The individual picture elements are described in the following section.

Figure 5-12
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Table 5-2

No. Object type

Description

1 WinCC OnlineTrendControl
LArchive ValueO1 Trend”

This trend shows the values of the archive tag
"#FastArchPgm#RawArchiv#A#00000001#0001",
which is detected by the CFC block Scan01.

2 WinCC OnlineTrendControl
LArchive Value02 Trend”

This trend shows the values of the archive tag
"Value02",
which is detected by the CFC block Scan02.

3 WinCC OnlineTableControl
LJArchive Value01 Table”

This trend shows the values of the archive tag
"#FastArchPgm#RawArchiv#A#00000001#0001"

The WinCC Online TableControl allows you to
export the archived values to a CSV file. Please
note that the exported file will only contain the
values of the selected time range.

4 WinCC OnlineTableControl
LJArchive Value02 Table”

This trend shows the values of the archive tag
"#Value02".

5 APL “OpDi01” block icon

This binary process operation allows you to activate
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5 Example project

No. Object type Description
~Start_SIM* and deactivate the test signal.

6 APL “OpDi01” block icon This binary process operation allows you to reset
.Reset_SIM* the test signal.

7 APL “OpDi01” block icon This binary process operation allows you to
»EnableArchiving“ start/stop the archiving of the process tags.

8 APL “MonAnS” block icon Monitoring of the process value “PV1”.
“Mon_PV1”

9 APL “MonAnS” block icon Monitoring of the process value “PV2”.
“Mon_PV2”

Fast archiving of process
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6 Operation of the example project

6.1 Operation viathe OS runtime

The easiest way of operating the Application Example is via the OS runtime. To do
this, use the configured elements in the OS area "FastArchiving" as described in
the previous section.

6.2 Operation via CFC

Besides operating via the OS runtime one can also operate all configured functions
directly from the CFC.

e Start/ stop archiving

Open the CFC chart "HMIconnection".
Activate the test mode in CFC

Set the input parameter
"LiOp" = 1 at the block "EnableArchiving".
Now the operation of the block is done via the inputs "SetLi" and "RstLi".

To start archiving, set the input parameter
"In" = 1 at the block "EnableArchLink"

To stop archiving, set the input parameter
"In" = 0 at the block "EnableArchLink"

e Deactivate test signal

To deactivate the test signal, proceed in accordance with the above
description.

e Reset the test signal when starting the archiving process

To automatically reset the test signal when starting the archiving process,
proceed in accordance with the above description.

Fast archiving of process
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6 Operation of the example project

6.3 Resetting the archive

When testing the fast process value archiving, there might be large amounts of
data that are not necessarily needed and which take up space.

If you want to delete this data, you can reset the WinCC archive "Tag Logging
Fast".

CAUTION  Note that when you reset this archive, all data in it will be deleted from the
project.

To reset the archive, proceed as follows:

1. Open the WinCC Tag Logging in WinCC Explorer.

2. Right click on "Archives" to open the associated context menu.
Navigate to "Archive Configuration> TagLoggingFast" and click on "Reset".

Figure 6-1
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3. If you are sure that you want all data in this archive to be deleted, confirm the
following dialog with "Yes".

Figure 6-2

>>WARNING< < x|

Do you really want to delete all archive data?

I

4. Save and close the WinCC Tag Logging.
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Table 7-1

Topic

\1\ Siemens Industry Online Support
https://support.industry.siemens.com

\2\ Download page of this entry
https://support.industry.siemens.com/cs/ww/en/view/23780904

8 History

Table Error! Use the Home tab to apply Uberschrift 1 to the text that you want to

appear here.—1

Version

Date

Change

V1.0

12/2006

First edition

V1.1

03/2009

Changing the time calculation from TIME to REAL
Extend the following block interfaces / functions
SAMPLE_TIME / cycle time OB
QFIFODEG / storage level
QNUM_TRANS / archived process values
QNUMSEND / data blocks sent
QNUMCONNECT / connected ARSCAN_E

V2.0

11/2013

e Complete revision of the document
Restructuring of the chapter
Validity for PCS 7 V8.0 Update 1

Project guidelines for quantity structures / limitations

e New example project based on PCS 7 V8.0 Update 1

e  SCL source files from version 1.2 are unofficial /
released on a project-specific basis

e SCL source file update to version 1.3

(for a complete list of changes, please check in the SCL

source files)

CAUTION
Interface change

Restructuring of the version history
Revision of comments

Streamlining of internal data management
Improvement of startup characteristics

V2.1

02/2015

e Documentation update to SIMATIC PCS 7 V8.1
e Example project update

V2.2

08/2016

e Documentation update to SIMATIC PCS 7 V8.2
e Example project update
e Miscellaneous adaptions
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